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Fejlesztõi sarok

A Trolltech egyik mér-
nöke beavat bennünket
a Qtopiával történõ
fejlesztés rejtelmeibe.

Trolltech által fejlesztett
Qtopia egy olyan beágyazott
alkalmazások fejlesztésére al-

kalmas fejlesztõi keretrendszer, amely
teljes szabadságot ad a forgalmazók-
nak az alkalmazások testreszabásával
kapcsolatban. Ezzel párhuzamosan
a cég lehetõvé teszi, hogy a GPL hatá-
lya alá tartozó alkalmazásokhoz
a Qtopia ingyenesen felhasználható
legyen, míg a kereskedelmi szoftverek
fejlesztõi meg is vásárolhatják azt.
Röviden tehát a Qtopia kétféle
licensszel kerül forgalomba. A rend-
szerrel történõ fejlesztés elsõ közelí-
tésben ugyanolyan, mintha a Qt/KDE

párost használnánk, eltekintve persze
néhány extra lépéstõl és eszköztõl.
Jómagam egy Gutenbrowser névre
keresztelt alkalmazást kezdtem fejlesz-
teni, ami nem egyéb, mint egy olvasó-
illetve letöltõprogram a Project Guten-

berg által kínált megszámlálhatatlan
szöveges dokumentumhoz.
A Gutenbrowser elõször kizárólag
Linuxon elérhetõ programként kezdte
a pályafutását, de aztán viszonylag
gyorsan megszületett a Windows,

Qtopia illetve Opie (Open Palmtop

Integrated Environment) változata is.
Az Opie amúgy egy a Qtopia GPL-es
változatán alapuló környezet,
amit egy teljes közösség fejleszt.
A Qtopia alapját a Qt Embedded fejlesz-
tõkörnyezet képezi, így minden, a Qt

segítségével megírt program könnyen
átalakítható úgy, hogy a Qtopia környe-
zetben és képes legyen futni. Nekem
körülbelül két hetembe telt, amíg „rész-
munkaidõs” nyílt forrású fejlesztõként
mûködésre bírtam a Gutebrowsert egy
Sharp Zauruson. Ebben pedig benne
volt magának a Qtopia API-nak a meg-
tanulása, valamit a többplatformos
fordítás elsajátítása is.
Aki most akarja elkezdeni a Qtopia

megtanulását, annak azt ajánlom,
hogy várja meg a Qtopia 4 megjelené-
sét, mivel jelentõs különbségek van-
nak a Qt Embedded 2.3-as és 4-es vál-
tozata között. Ami az átjárhatóságot
illeti, Qt3, KDE sõt még GTK+ alkal-
mazásokat is sikeresen portoltak már
a Qtopia 1-es és 2-es változataira, de
ehhez szükség volt némi extra munká-
ra. Helyettesíteni kellett bizonyos osz-
tályokat, a KDE programokhoz pedig
a microkde forrása is szükséges volt.

Milyen eszközökre lesz szükségünk
Ahhoz, hogy megkezdhessük a mun-
kát a Qtopia-val elõször is szükségünk
lesz néhány segédeszközre. A Qtopia

jelenleg csak Linuxon használható
tehát szükségünk lesz egy ilyen
operációs rendszert futtató gépre.
Nyilván kell majd egy olyan képessé-
gekkel rendelkezõ szövegszerkesztõ,
mint amilyen az emacs vagy a vi.
Én a saját projektemben történe-
tesen a KDevelopot használtam,
amely rendelkezik egy igen egy-
szerû Qtopia sablonnal.
Ha valamilyen speciális eszközre
fejlesztünk alkalmazást, akkor szüksé-
günk lesz egy keresztfordítóra is. Ese-
tünkben az eszköz legyen az Archos

PMA430, ami a Qtopia-hoz az arm-

linux-gcc 2.95-ös változatát használja.
Bár az igaz, hogy a GCC 3-as jobban
optimalizál, alkalmazásunknak kom-
patibilisnek kell maradnia az eszközön
futó egyéb szoftverekkel, tehát öre-
gecske ugyan a 2.95-ös, most mégis
megteszi. Az ARM rendszerekre törté-
nõ fordításhoz szükséges eszközök az
interneten számos helyen fellelhetõk.
Esetünkben az Archos eszközkészletet
a �www.archos.com/products/overview/

pma_400_sdk.html címen találjuk,
de számos más link is fellelhetõ
a � qtopia.net webhelyen.

Forráskód vagy kész SDK?
Természetesen a Qtopia-t magát sem
nélkülözhetjük, de itt is van két vá-
lasztási lehetõségünk: letölthetjük
a forráskódot, vagy használhatunk

Qtopia – Az elsõ lépések
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egy lefordított Qtopia SDK csomagot
is. Ami a PMA430 platformot illeti
a fejlesztõkészlet GPL és kereskedelmi
változatban egyaránt fellelhetõ, akár-
csak a Qtopia maga. A kereskedelmi
csomagot a � www.trolltech.com/

products/qtopia/pricing.html

webhelyen szerezhetjük be teljesen el-
fogadható összegért, míg a szabad, va-
gyis a GPL hatálya alá tartozó csoma-
got a � ftp.trolltech.com/qtopia/sdk

helyrõl tölthetjük le. Mindkettõ
a /opt/Qtopia könyvtárba kerül telepí-
tés után. Ha nincs /opt/Qtopia/arm

könyvtárunk, akkor telepítés után
adjuk ki a következõ parancsot:

# ln -s /opt/Qtopia/sharp

�/opt/Qtopia/arm

A KDevelop projekt
Indítsuk el a KDevelop fejlesztõkör-
nyezetet, majd a Project menübõl vá-
lasszuk a New Project pontot. Nyissuk
meg az Embedded könyvtár alatt talál-
ható C++ könyvtár ikont. Kattint-
sunk a Qtopia Application nevû fájlra,
amellyel egy új Qtopia projektet nyi-
tunk meg. Ennek elvileg bármilyen
nevet adhatunk, hívhatjuk akár víziló-

nak is. A projekt létrehozására szolgá-
ló dialógusablak az 1. ábrán látható.
Ha megnyitottuk az új projektet,
elkezdhetjük azt saját igényeinknek
megfelelõen átszerkeszteni. Ha egy
Qtopia projekthez szerkesztünk .ui

(user interface) fájlokat, ehhez min-
denképpen a Qt 2-ben található
Designert használjuk, mivel a késõbbi
változatokkal készített fájlok nem
kompatibilisek a Qtopia-val. Én ezt
úgy oldottam meg, hogy felvettem
egy egyedi külsõ eszközt, és az .ui fáj-
lokat a Designer 2-bõl nyitottam meg.
Ezen a ponton érdemes megjegyezni,
hogy nem szabad a .ui fájlokat dupla
kattintással megnyitni, mivel ennek
hatására a Designer 3 fog elindulni,
mivel a KDevelopban alapértelmezés-
ként ez van hozzárendelve ehhez
a fájltípushoz. Ha ezt el akarjuk
kerülni, akkor a KDevelop rendszert
parancssorból kell futtatnunk úgy,
hogy elõtte megadjuk a következõ
környezeti változókat:

export PATH=/opt/Qtopia/

�bin:$PATH

export LD_LIBRARY_PATH=/opt/

�Qtopia/lib:$LD_LIBRARY_PATH

Szintén célszerû beállítani QVFb né-
ven a Qt Virtual framebuffert, amely
célszerûen a /opt/Qtopia/bin/qvfb

helyre kell mutasson. Ebben a virtu-
ális környezetben fut majd az éppen
fejlesztet alkalmazásunk a felhasználói
felületen. A Qtopia közvetlenül
a frambufferben jeleníti meg a kime-
netét, vagyis nem terheli az X11

kiszolgálót.

A környezet beállítása
Elõször is meg kell adnunk néhány
környezeti változót a KDevelop pro-
jekthez. Indítsuk el a KDevelop rend-
szert, majd kattintsunk sorrendben
a Project->Project Options->Run

Options pontokra. Ezután hozzuk
létre a következõ változókat:

Name: QTDIR Value: /opt/Qtopia

Name: QPEDIR Value: /opt/Qtopia

Name PATH Value: /opt/Qtopia/

�bin:$PATH

Name LD_LIBRARY_PATH Value: /opt/

�Qtopia/lib:$LD_LIBRARY_PATH

Hasonlóan a Make Options alatt is
meg kell adnunk néhány értéket:
A skizzy.pro projektfájlban a LIBS

értékéhez adjuk hozzá a -lqtopia

opciót, mivel a Qtopia 1.7 rendelkezik
egy saját könyvtárral. Ezen a ponton
a Makefile-t kézzel kell létrehoznunk,
mivel a KDevelop hibásan használja
a tmake programot:

# export TMAKEPATH=/opt/Qtopia/

�tmake/lib/qws/

�linux-generic-g++

# tmake -o Makefile skizzy.pro

Ha mindezzel megvagyunk, az F8

leütésével indíthatjuk a projekt fordí-
tását. Ez az utóbbi probléma termé-
szetesen kiküszöbölhetõ, így a Qtopia

késõbbi változatai már a qmake prog-
ramot fogják használni a Makefile

felépítéséhez.

A beltartalom
Hozzáláthatunk az igazi fejlesz-
téshez, vagyis elkezdhetjük fel-
ruházni alkalmazásunkat néhány
funkcióval.
Indítsuk el a Designer 2 alkalmazást,
és nyissuk meg vele a skizzybase.ui

fájlt. Töröljük belõle a Qlabel-t.
Hozzunk létre ugyanakkor egy
QTabWidget objektumot egy

11..  áábbrraa Új Qtopia projekt létrehozása
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QComboBox-szal egyetemben az elsõ
fülön, egy QlistBox-ot a másodikon,
egy QMultiLineEdit elemet pedig
a harmadikon (2. ábra).
Mentsük a módosított .ui fájlt.
Nyissuk meg a skizzy.cpp fájlt
a KDevelop-ból. Látható, hogy
az általunk fejlesztet alkalmazás
a skizzyBase-bõl van származtatva:

skizzy::skizzy( QWidget*

�parent, const char* name,

�WFlags fl )

: skizzyBase( parent,

�name, fl )

Szeretném megváltoztatni a main.cpp-t
úgy, hogy az alkalmazás létrehozására
egy olyan hatékonyabb metódust
használjon, ami az után jelent meg,
hogy létrehozták a KDevelop rendszer
Qtopia sablonját.
Ehhez a szokásos main() függvényt
fogjuk megváltoztatni, amely eredeti
állapotában így fest:

int main( int argc, char **

�argv )

{

QPEApplication a( argc,

�argv );

skizzy mw;

a.showMainWidget( &mw );

return a.exec();

}

22..  áábbrraa A QLayouts használatával
elérhetjük, hogy alkalmazásunk
automatikusan a megjelenítõ
felbontásához igazodjon

1. Lista Azon függvények megvalósítása, amelyekhez az alkalmazás által
használt widget-ek jeleit kapcsoljuk

/*

Ez a függvény a Qtopis FontDatabase eszközét használja

arra, hogy egy combo dobozt feltöltsön fontok neveivel. 

*/

void skizzy::fillCombo()

{

QStringList families = fontdb.families();

for ( QStringList::Iterator f = families.begin(); f 

�!= families.end();++f ) {

QString family = *f;

ComboBox1->insertItem( family);

}

}

/*

Ez a függvény akkor fut le, amikor a felhasználó kiválasztja

a combo dobozt, Kitölti a második fülön található listadobozt

azoknak a fontoknak a nevével, stílusával és méretével,

amelyeket a felhasználó kiválasztott. */

void skizzy::comboSelected(const QString &selectedFont)

{

ListBox1->clear();

QStringList styles = fdb.styles( selectedFont );

for ( QStringList::Iterator s = styles.begin(); s != 

�styles.end();++s ) { 

QString style = *s;

QValueList<int> smoothies = fdb.smoothSizes

�( selectedFont, style );

for ( QValueList<int>::Iterator points = 

�smoothies.begin(); points != smoothies.end(); 

�++points ) {

QString pointSize = selectedFont + " "+ 

�style +" "+QString::number( *points ) 

�+ " ";

ListBox1 ->insertItem( pointSize);

}

}

TabWidget2->showPage(tab2);

}

/*

Ez a függvény egy mintaszöveget mutat meg a QMultiLineWidget

segítségével.

A szöveg a felhasználó által kiválasztott fonttal jelenik meg

a harmadik fülön. */

void skizzy::showFont( QListBoxItem *item)

{

QStringList fontItemString = QStringList::split

�(' ',item->text());

QString family, style, point;

family = fontItemString[0]; 

style = fontItemString[1];
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A változás lényege, hogy a fenti
függvényt lecseréljük a Qtopia

alkalmazásmakrójára:

QTOPIA_ADD_APPLICATION("skizzy",

�skizzy);

QTOPIA_MAIN

Ez a módosítás lehetõvé teszi, hogy
gyorsan indítható alkalmazást hoz-
zunk létre, hiszen a lényeg itt annak
a közös alkalmazás-konstruktornak
a használata, amely már eleve
a memóriában van.
Alkalmazásunk egyelõre nem csinál
semmi értelmeset, tehát most már
valóban álljunk neki az érdemi
munkának a következõképpen:

#include <qpe/fontdatabase.h>

Hozzunk létre egy privát tagot:

FontDatabase fdb;

Aztán néhány függvény és privát slot

következhet:

private slots:

void fillCombo();

void comboSelected(const

�QString &);

void showFont( QListBoxItem *);

A skizzy.cpp fájlban meg kell adnunk
még néhány kiegészítõ sort ahhoz,
ami hamarosan következik:

#include <qstringlist.h>

#include <qcombobox.h>

#include <qtabwidget.h>

#include <qlistbox.h>

#include <qmultilineedit.h>

#include <qfont.h>

#include <qfontinfo.h>

#include <qpe/fontdatabase.h>

Aztán meg kell valósítanunk
azokat a függvényeket, amelyek-
hez a widget-ek jeleit kapcsoljuk
(1. Lista).
A Qt és a Qtopia egyaránt
jeleket használ a widget-ek
közti kommunikáció lebonyolí-
tására. Minden widgetnek meg-
vannak a kibocsátható jelei,
amelyeket a kapcsolati makrók
segítségével köthetünk a megfelelõ
függvényekhez.
Kapcsoljuk például a ComboBox1

activated jelét, valamit a ListBox1

clicked jelét a saját slotjainkhoz
a következõképpen:

skizzy::skizzy( QWidget*

�parent, const char* name,

�WFlags fl )

: skizzyBase( parent, name,

�fl )

{

connect(bye, SIGNAL

�(clicked()), this,

�SLOT(goodBye()));

connect(ComboBox1, SIGNAL

�(activated(const QString

�&)), this, SLOT

�(comboSelected(const

�QString &)));

connect(ListBox1, SIGNAL

�( clicked ( QListBoxItem

�* )), this, SLOT(showFont

point = fontItemString[2];

bool ok;

int i_size = point.toInt(&ok,10);

if (!ok) {

style += " "+fontItemString[2];

point = fontItemString[3];

i_size = point.toInt(&ok,10);

}    

QFont selectedFont( family);

selectedFont.setPointSize(i_size);

if(style.find("Italic",0,TRUE) != -1) {

selectedFont.setItalic(TRUE); 

}

if(style.find("Bold",0,TRUE) != -1) {

selectedFont.setWeight(QFont::Bold);

}

if(style.find("Light",0,TRUE) != -1) {

selectedFont.setWeight(QFont::Light);

}

MultiLineEdit1->setFont( selectedFont);

MultiLineEdit1->setText( tr( "The Quick Brown Fox Jumps 

�Over The Lazy Dog" ) );

MultiLineEdit1->setWordWrap( QMultiLineEdit::WidgetWidth);

TabWidget2->showPage(tab3);

}

1. Lista folytatás

33..  áábbrraa A kész program a néhány nem
túlságosan hasznos funkcióval
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�( QListBoxItem*)));

fillCombo();

}

Figyeljük meg, hogy a slotot kezelõ
függvény pontosan ugyanolyan típu-
sú argumentumot fogad, mint ami-
lyen az õt vezérlõ jel típusa.
A KDeveleopban nyomjuk meg
az F8-at, vagy válasszuk a Build

menübõl a Build Project pontot.
A program ennek hatására a natív
fordítóprogram használatával lefor-
dul. Ha futtatni akarjuk, indítsuk el
a QVFb-t, majd egyszerûen válasszuk
a Build menübõl az Execute Main

Program pontot. Programunk ennek
hatására megjelenik a QVFb keret-
rendszerben.

Más platformra történõ fordítás
Most tehát van egy úgy ahogy mûkö-
dõ programunk, de egyelõre csak
a fejlesztéshez használt gépen fut.
Le kell tehát fordítanunk az Archos

rendszerére is. A megfelelõ könyvtá-
rak használatához elõször is meg kell
változtatnunk a projekt tulajdonságait.
Mivel immár készen állunk
a valódi eszközre való fordításhoz,

törölhetjük is az eredeti projek-
tet a Build menü Clean Project

pontjával.
A Project Options->Make Options

dialógus segítségével végezzük el
a következõ módosításokat:

Name: QTDIR Value: /opt/

�Qtopia/arm

Name: QPEDIR Value: /opt/

�Qtopia/arm

Name PATH Value: /usr/local/

�arm/bin:/opt/Qtopia/tmake/

�bin:$PATH

Name TMAKEPATH Value:/opt/

�Qtopia/tmake/lib/qws/

�linux-arm-g++

Töröljük a Makefile-t, majd futtassuk
a parancssorból a következõ parancsot
annak a Makefile-nak a létrehozásá-
hoz, ami már az arm-linux fordítót
használja:

# export TMAKEPATH=/opt/Qtopia/

�tmake/lib/qws/linux-arm-g++

# tmake -o Makefile skizzy.pro

A projekt lefordításához üssük le az
F8 billentyût. A keletkezõ bináris állo-

mányt USB porton átmásolhatjuk az
Archos eszközre, és ott futtathatjuk.
Ha telepítõcsomagot akarunk létre-
hozni, akkor nem árt tudni, hogy
a Qtopia a handhelds.org webhelyen
található Itsy Package Managemenet

(röviden ipkg) használja a progra-
mok telepítésére. Aki többet szeret-
ne errõl megtudni, az látogasson
el a Trolltech Qtopia.net címen talál-
ható webhelyére.
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LLoorrnn  PPootttteerr

a Trolltechnél dolgozik
mint a Qtopia közösség
vezetõje (Qtopia
Community Manager).
Amerikai, de jelenleg

Ausztráliában, Brisbane-ben él auszt-
rál feleségével és fiával. A nyílt forrá-
sú programok fejlesztését saját erejé-
bõl tanulta meg. Jelenleg az Opie
(Open Palmtop Integrated
Environment) Projekt egyik vezetõ
fejlesztõje. Korábban zenészként,
hangmérnökként és síõrültként
is dolgozott.
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